ENGLISH

(For the Canon Digital Camera Solution Disk Version 29)

Windows/Macintosh

Software Starter Guide
You must install the software bundled on the Canon
Digital Camera Solution Disk before connecting the
camera to the computer.

Windows
Macintosh

Connect the camera
to the computer.

Windows

Install the
software.

p. 11
p. 44
Macintosh

• This guide explains how to install the software programs and
briefly introduces their functions and operating procedures.

SAFETY PRECAUTIONS
The precautions noted within this guide are intended to instruct you in the safe and correct use of
the products and to prevent injuries or damage to yourself, other persons and property. Please
read and ensure that you understand them before proceeding to other sections of the guide.

Warnings

This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

Warnings
• Do not play the supplied CD-ROM(s) in any CD player that does not support data CDROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer from hearing loss from listening with headphones to
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.
• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.
• Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the memory cards,
personal computers, peripheral devices, or use of non-Canon memory cards.

Trademark Acknowledgments
• Macintosh, Mac OS and QuickTime are trademarks of Apple Computer Inc., registered in the
United States and other countries.
• Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.
Copyright © 2006 Canon Inc. All rights reserved.
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Read This First

About this Guide

• The explanations in this guide are based on Windows XP and Mac OS X v10.3. If you are
using another version of these operating systems, the actual screen contents and
procedures may vary slightly from those shown.
• The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.2-v10.4)

Method for Downloading to a Computer without Additional Software
Your camera uses a standard image transfer protocol called Picture Transfer Protocol (PTP).
With PTP and Windows XP or MaC OS X, you can download images without having to install
additional software. However, there are some inconveniences and limitations to this
downloading method. See the For Windows® XP and Mac OS X Users leaflet for details.

Windows/Macintosh

This chapter explains what you can accomplish using the camera with the software contained
on the Canon Digital Camera Solution Disk.
It also lists the computer system configurations required to use the software.
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Read This First

It’s so Simple! Make Prints Right at Home
Like a Pro
Shoot the images
Windows/Macintosh

See your Camera User Guide for shooting instructions.

Install the software on the
computer

Windows (p. 11)
Macintosh (p. 44)

Just install the software once at the beginning.
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Read This First

Connect the camera to the computer

See your Camera User Guide for connecting instructions.

Download images to the computer

Windows (p. 16)
Macintosh (p. 46)

Print the images

Windows (p. 21)
Macintosh (p. 50)

Windows/Macintosh

Precautions for
Connecting the
Camera to the
Computer (p. 10)
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Unbounded Possibilities with Entertaining
Software
Print a Variety of Layouts

With One Photo per Page Print,
printing images is also easy.

Confirm all your images in one glance
with index (contact sheet) printing.

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch.

Windows/Macintosh

Print with the diverse layouts available in ZoomBrowser EX (Windows) and ImageBrowser
(Macintosh). The examples shown are from ZoomBrowser EX (Windows).

Read This First
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Send an Image as an E-mail Attachment
Attach an image to an e-mail message by starting your mail software from within
ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Windows/Macintosh

Operate the Camera Shutter from the Computer
You can use ZoomBrowser EX (Windows) or ImageBrowser (Macintosh) to operate the camera
shutter from the computer to shoot images (Remote Shooting). The recorded images are
downloaded directly to the computer.

The shutter is operated from the computer.

Edit a Movie
You can edit movies, linking movies and stills that have been downloaded to the computer,
adding text, such as titles, adding background music or applying various special effects.

Extract Stills from Movies
You can extract a still from the displayed movie and save it as a new image file. You can also
specify a range of frames and extract multiple stills.
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System Requirements
Please install the software on a computer meeting the following minimum requirements.

Windows
Windows 98 Second Edition (SE)
Windows Me
Windows 2000 Service Pack 4
Windows XP (including Service Pack 1 and Service Pack 2)

Computer Model

The above OS should be pre-installed on computers with built-in USB
ports.

CPU

Pentium 500 MHz or higher processor

RAM

Windows 98 SE/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more

Interface

USB

Free Hard Disk
Space

•Canon Utilities
- ZoomBrowser EX:
- PhotoStitch:
•Canon Camera TWAIN Driver:
•Canon Camera WIA Driver:

Display

1,024 x 768 pixels/High Color (16 bit) or better

200 MB or more
40 MB or more
25 MB or more
25 MB or more

Macintosh
OS

Mac OS X (v10.2-v10.4)

Computer Model

The above OS should be pre-installed on computers with built-in USB
ports.

CPU

PowerPC G3/G4/G5 or Intel Processor*

RAM

256 MB or more

Interface

USB

Free Hard Disk
Space

•Canon Utilities
- ImageBrowser:
- PhotoStitch:

Display

1,024 x 768 pixels/32,000 Colors or better

200 MB or more
40 MB or more

* EOS Utility (software for EOS DIGITAL series cameras) is only supported by PowerPC

Windows/Macintosh

OS
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Programs and Compatible Operating Systems
The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all models. It
contains the following programs.

Windows Programs
Compatible OS
Program

Windows Windows Windows Windows
98 SE
Me
2000
XP*2

Major Functions
Downloading, displaying,
organizing and editing images
Driver for Canon brand cameras (for
Windows 98, Windows 2000)
Driver (Windows Me)
Merging images to make panoramas
Downloading images and other
functions for EOS DIGITAL series
cameras

ZoomBrowser EX
TWAIN Driver
WIA Driver
PhotoStitch*1
EOS Utility
*1 Can be started from within ZoomBrowser EX.
*2 Installation of the driver is not required.

Macintosh Programs
Compatible OS
Program

Mac OS X

ImageBrowser
PhotoStitch*1
EOS Utility
*1 Can be started from within ImageBrowser.

Major Functions
Downloading, displaying, organizing and editing images
Merging images to make panoramas
Downloading images and other functions
for EOS DIGITAL series cameras

Windows/Macintosh

• A CD-ROM drive is required to install the software.
• Even when system requirements are met, not all computer functions can be
guaranteed.
• A sound card is required to play movie file audio tracks under Windows.
• With Windows, QuickTime 6.5 is required to save images merged with
PhotoStitch as the QuickTime VR type. It is also required to play and edit
movies on the Windows 98 SE, Windows Me and Windows 2000 platforms.
QuickTime is included on the Canon Digital Camera Solution Disk.
• Macintosh software cannot be used on disks formatted in the UFS (Unix File
System) format.

Read This First
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Before You Connect the Camera to the Computer
Ensure that you have installed the software from the supplied Canon Digital
Camera Solution Disk before you connect the camera to the computer.

• The connection may not operate correctly if you attach the camera to the computer with an
interface cable via a USB hub.
• The connection may not operate correctly if you are using other USB devices, excluding USB
mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.
• Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.
• Never allow the computer to go into standby (sleep) mode while a camera is connected via
the USB interface cable. If it does happen, never disconnect the interface cable. Try to awaken
the computer with the camera in the connected state. Some computers will not awaken
properly if you disconnect the camera while they are in standby (sleep) mode. Please refer to
your computer manual for instructions regarding the standby (sleep) mode.
• You are recommended to power the camera from a household power source
(AC adapter) when connecting to a computer (if available for your camera
model). Ensure that you use fully charged batteries if you will not be using a
household power source.
• See the Camera User Guide for procedures connecting the camera to the
computer.

Windows/Macintosh

Precautions for Connecting the Camera to the Computer
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Using the Software on the Windows
Platform – Preparations
This chapter explains the basic procedures for installing the software and connecting the
camera to a computer. Read this material before you connect the camera to the computer.

Installing the Software and USB Driver
Start by installing the software from the Canon Digital Camera Solution Disk.
• You must install the software before you connect the camera to the
computer.
• Users of Windows XP and Windows 2000 must first log in as an Administrator
(computer system administrator) to install programs.

• Your camera and computer
• Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

Installation Procedures
1 Confirm that the camera is NOT connected to

the computer.
If it is, disconnect the cable. The software cannot
be properly installed if the camera is connected to
the computer at the start.

2

Close any programs that are running.

Windows

Items to Prepare

12
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3

Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.
If the installer panel does not appear automatically, use the
following procedures.

How to Display the Installer Panel

Use the following procedures to display the installer panel if it does not appear
automatically.

Windows XP

1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [SETUP.EXE]

icon.

Windows 2000, Windows Me, Windows 98 SE

1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].

4

Click the Digital Camera Software [Easy
Installation] button.
To individually select the software to install,
click [Custom Installation].

Installer Panel

Windows

3. Double-click the [SETUP.EXE]
icon.
Some computers may not display the [.EXE] file name extension as shown above.

Using the Software on the Windows Platform – Preparations
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6
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If other software is running, close each
program before clicking [OK].

Review the installation settings and
click [Install].

The items displayed here differ according to
the software installed.

7

Click [Yes] if you agree to all of the
terms of the software license
agreement.
The installation will start.
Follow the onscreen instructions to
proceed.

Windows

When [Custom Installation] is Selected
The USB driver (the software for connecting) is required when the camera
is connected to the computer with an interface cable. Ensure that you
select a USB driver from below (the appropriate one for your operating
system).
•Windows 2000/Windows 98 SE: Canon Camera TWAIN Driver
•Windows Me: Canon Camera WIA Driver
With Windows XP, the USB driver supplied with the Windows operating
system is used so there is no need to install a USB driver.

Using the Software on the Windows Platform – Preparations
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When the installation is over, select
[Restart computer immediately
(Recommended)] and click [Restart].
At this stage, do NOT remove the Solution
Disk from the CD-ROM drive yet.

If there is no need to restart the computer, the [Finish] screen will display. Click [Finish],
remove the Solution Disk from the CD-ROM drive and proceed to Step 10.
Users of Windows XP and Windows 2000 must log in as an Administrator
(computer system administrator) after restarting to carry out the
subsequent procedures.

9

If you installed a USB driver, so far the required files have only been
copied to your computer. You must now connect the camera to the
computer with the interface cable to complete the installation and
prepare the driver for use.
See Uninstalling the Software (p. 72) to delete the installed programs.

10 Attach the camera to the computer with the
interface cable and set the camera to the
correct mode for connecting.

Windows

Remove the disk from the CD-ROM drive when your
normal desktop screen appears after restarting.
This concludes the software installation.
Continue by connecting the camera to the computer so
that the USB driver can be utilized.

Using the Software on the Windows Platform – Preparations
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Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.
If the Digital Signature Not Found window
appears, click [Yes].

The USB driver will automatically finish installing onto the computer when you attach the
camera and open a connection.
Dialogs similar to the following will appear during this process (first time the camera is
connected to a computer only).
Windows XP
The dialog on the right will appear after a
few moments.

Windows

Windows 2000/Windows Me/Windows 98 SE
Restart the computer according to the instructions if you are prompted to do so by a
message.
A dialog allowing you to set the default settings will display after installation. See Using
the Software on the Windows Platform – The Basics (p. 16) for the subsequent
procedures.
• See USB driver installation not proceeding well in the Troubleshooting
section (p. 76) if you are having problems installing the USB driver.
• See Uninstalling the USB Driver (p. 73) to delete the USB driver installed
with these procedures.
• See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 83) if you
were previously using either version.
This concludes the software and USB driver installation and the procedures for connecting the
camera to the computer.
You may now download camera images to the computer (p. 16).
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Using the Software on the Windows
Platform – The Basics
This chapter explains the procedures for using ZoomBrowser EX to download the camera's
images to the computer and print them.
Read this chapter after completing the preparations in the Using the Software on the Windows
Platform – Preparations section.

Downloading Images to the Computer
Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 19).
You may not be able to download images when the camera is connected to a
computer if there are a large number of images (approximately 1000) on the
memory card. Use a memory card reader to download in that case.

DIGITAL Terminal. Prepare the camera for communication with the computer.

Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See the
Camera User Guide.
The Camera Control Window will appear.

Camera Control Window

Windows

Camera to Computer Connection
1 Attach the supplied interface cable to the computer’s USB port and the camera’s

Using the Software on the Windows Platform – The Basics
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First Time Camera is Connected to a Computer
Set the following settings the first time you connect the camera to the computer. These
procedures are not required from the second connection onward.
Select [Canon CameraWindow] when a
dialog (Events dialog) similar to that on
the right displays and click [OK].
Your camera model name or [Canon
Camera] will appear here.
Different programs may display
according to your computer setup.

2

Download the images.
Download the images using the camera or
the computer. By default, the downloaded
images are saved into the [My Pictures]
folder.

Placing a check mark here causes this
window to automatically open when the
camera and computer are connected.
You can adjust the settings, such as the type
of image downloaded and the destination
folder, by clicking [Preferences].

Windows

If this Events dialog does not appear, click the [Start] menu and select
[All Programs] or [Programs], followed by [Canon Utilities],
[CameraWindow], [PowerShot - IXY - IXUS - DV 6] and
[CameraWindow].

Using the Software on the Windows Platform – The Basics
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Using the Camera to Download Images (Direct Transfer Function)
• If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the
(Print/Share) button will light if your camera is equipped with one.
• See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.
Set the Direct Transfer settings on the
camera and press the
(Print/Share)
button or the SET button.

Using the Computer to Download Images
Click [Starts to download images].

Windows
• By default, all the images that have yet to be downloaded will download.
•To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.
• Click [Lets you select and download images] to show the camera images
in a list, check the images before downloading and download only
selected images.

Using the Software on the Windows Platform – The Basics
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The downloaded images are saved into
folders according to the shooting date.
At the same time, they will also appear
grouped by date in the [Last Acquired
Images] at the top of the Folder Area.
[Last Acquired Images]
The last downloaded images will display according
to their shooting dates.
Destination for the downloaded images

The downloaded symbol displays on
downloaded folders.

Folder area

Thumbnail

According to the default settings, the thumbnails (tiny versions) of the downloaded images
display in the Main Window when the downloading is complete.

Next, print out the images (p. 21).

Use a separately sold card adapter if required.
See the manual for the memory card reader for its connection and handling instructions.

2

Select [View/Download Images using
Canon CameraWindow] when the
dialog to the right appears and click
[OK].
The Camera Control Window will display.

If the dialog above fails to appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [CameraWindow],
[PowerShot - IXY - IXUS - DV 6] and [CameraWindow], and proceed to
Step 3.

Windows

Memory Card Reader Connection
1 Insert the memory card into the reader.

Using the Software on the Windows Platform – The Basics
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Click [Starts to download images].

You can adjust the settings, such as the type
of image downloaded and the destination
folder, by clicking [Preferences].

The downloaded images are saved into folders according to the shooting date.
At the same time, they will also appear grouped by date in the [Last Acquired Images] at
the top of the Folder Area.
Next, print out the images (p. 21).

Windows

• By default, all the images that have yet to be downloaded will
download to the [My Pictures] folder.
• To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.
• Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.
• See Memory Card Folder Structure (p. 75) for information about
memory card folder structures and file names.

Using the Software on the Windows Platform – The Basics
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Printing Images
There are two ways in which images may be printed: One Photo per Page Print and Index Print.
This section explains the One Photo per Page Print method.
• Movies cannot be printed, but you can print stills after they have been
extracted from movies and saved to files.
• To use the Index Print option, click [Print] in the Main Window, followed by
[Index Print].

One Photo per Page Print
This option prints one image per page in a standard "photo" format. If you select multiple
images, it will print them on the corresponding number of pages.

1

Click [Print] in ZoomBrowser EX's Main Window, followed by [One Photo Per Page
Print].

Windows
• If you have installed the EasyPhotoPrint program that
accompanied a Canon-brand
printer, you will proceed to the
Easy-PhotoPrint printing window
shown at the right when you
select [One Photo per Page Print]
according to the default settings.
If a window similar to it opens,
read the Help menu for EasyPhotoPrint for instructions to proceed.
• To proceed to the ZoomBrowser EX printing window as shown in Step 2
when you select [One Photo per Page Print], click the [Tools] menu and
select [Preferences], followed by the [Printing] tab. Select [Use the Print
Function in ZoomBrowser EX].

22
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2

After confirming that [1. Select Images] is selected, select images.
You can select multiple images by holding the [Ctrl] down while clicking on successive
images.

The background of
selected images
changes to blue.

3

Click [2. Printer and Layout Settings] and adjust the categories as you feel
necessary.

Windows

Selects the printer
and the paper size
etc.

Sets printing to
"borderless," etc.
Place a check mark
here to print
shooting date/time
information with
images.

Sets the number
of print copies
This button switches between images if
multiple images were selected.

4

Click [3. Print].
Printing will start.

Using the Software on the Windows Platform – The Basics
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This chapter explained the ZoomBrowser EX basics. Once you have mastered them, try the
advanced techniques.
Using the Software on the Windows Platform – Advanced Techniques (p. 24).

Using Cameras That Support My Category
When using cameras that support My Category, in addition to classifying by Shooting Date,
My Category also displays at the top of the folder area where the [Last Acquired Images]
message displays after the last image is downloaded.
Also, in addition to the Star Rating it is possible to sort by Category using the [Filter Tool]
function.

Windows

24

Using the Software on the Windows
Platform – Advanced Techniques
This chapter explains various ZoomBrowser EX features.
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the
Using the Software on the Windows Platform – The Basics chapter.
To confirm whether your camera supports these functions, please refer to
Information about Your Camera (p. 85).

The ZoomBrowser EX Windows
This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer
Window and Properties Window.

This window is for displaying and organizing images downloaded to the computer.
Task Area (p. 25)

Function Buttons (p. 27)

Display Mode
(p. 26)
Display Control
Panel (p. 27)

Browser Area (p. 25)
Folders Area (p. 25)

Switches between showing and hiding
the Task Area and Folders Area.

Windows

Main Window

Using the Software on the Windows Platform – Advanced Techniques
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Task Area
• ZoomBrowser EX's tasks are arranged here like
an index.
• Click a Task button to carry out the desired
task.
These features are described in ZoomBrowser
EX Features (p. 30)

Folders Area
• Use this area to select folders. The images in the selected folder display in the Browser Area.
If you select a network drive in advance with Windows Explorer, you can display network
folders, but you cannot add, change or delete those folders in the Browser Area.
• If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder

• If [Favorite Folders] is displayed: click [Add] and select a folder.
• If [All Folders] is displayed: select a folder and click [Add to Favorites].
• To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.
• Downloaded images also appear in the [Last Acquired Images] area at the top of the Folder
Area. You can check them in groups sorted by shooting date.

• The images in the folder selected in the Folders Area will display here.
The display style will vary according to your Display Mode selection.

Methods for Selecting Images in the Browser Area

• Selecting a single image: click on an image.
• Selecting multiple images: click on the first image and then hold the [Ctrl] key down
while clicking on additional images.
• Selecting consecutive images: click on the first image and then hold the [Shift] key down
while clicking on the last image.
• You can sort the image order in the Browser Area by file name, shooting date or other
characteristics by clicking the [Tools] menu and selecting [View] and [Sort by].
• The following icons will display around images according to their attributes.
Images shot with the camera's Stitch Assist mode
RAW images
Movies
Images with sound memo attachments
Protected images
Images shot with the camera's AEB function
Images or movies rotated in display only

Windows

Browser Area

Using the Software on the Windows Platform – Advanced Techniques
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Display Mode
• Selects the display style for the Browser Area.

Zoom Mode

Displays all the images in a folder as thumbnail
images. This mode is convenient for searching
for images since many can be displayed at
once.
If additional folders are nested within a
folder, their images are displayed as
thumbnails as well.
If you move the mouse cursor over a folder,
will display on the upper right. Clicking
here displays that folder zoomed in.

Scroll Mode

The images within the selected folder and
subfolders will display. If you set the display
folder depth (level) to [1] or greater, the
thumbnails of the images in the folder will also
display. You can change the folder depth in the
[Tools] menu under the [Preferences] option.

Windows

Preview Mode

This mode displays the image at a larger size as
well as the image information.

Positioning the mouse pointer over a thumbnail causes the image to appear
at a higher magnification in a Mouse Over Window. You can turn off this
function by clicking the
[Show Information], and removing the check
mark from the [Show Mouse Over Windows] option.

27
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Display Control Panel
• This panel adjusts the display settings for the Browser Area.
Selection Menu
Click this to select/deselect all
images in the Browser Area.

Fit to Window
Changes the thumbnail size to
fit them into the window.

Display Size
Changes the size of the
thumbnail in the Browser Area.

Filter Tool Menu
Displays only images that
correspond to the specific
conditions.

Show/Hide Image Information Menu
Select here to show/hide such image
information as the file name or
shooting date or rating beneath the
thumbnail.
Select Button
Use this to select images
in Zoom mode.

Function Buttons
• These buttons are available for executing various functions.
Slide Show Button
Starts a slide show of the
selected images.

Properties Button
Displays information about
the selected image in the
Properties Window.

Rotate Button
Rotates the selected
image.

Delete Button
Search Button
Deletes selected
Searches for images
using such criteria as the images or folders.
Star Rating,
modification date,
shooting date,
comments or keywords.

Windows

View Image Button
Displays the selected image
or movie in the Viewer
Window.

28
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Viewer Window
Double-click an image in the Browser Area to display it in the Viewer Window.
Edit Menu
You can edit, eliminating red eyes,
adjusting colors, cropping and
inputting titles. You can also use it to
start up other programs for editing.
Print Button
Prints the displayed image.

Display AF Frame
Displays the AF Frame
(area used to focus).
Shooting
Information
Display Button
Displays image
shooting
information.

Synchronize Button
Synchronizes the
display settings when
multiple images are
displayed.

Number of
Displays
Button
Displays
multiple
images at
once. This is
handy for
comparing
images.

Image Selector
Button
Switches between
images.
Displays images in
the Viewer
Window at their
actual size.

Windows

Sets the image
display size to the
size in the Viewer
Window.

Zoom
Changes the image
zoom setting.

Star Rating
Sets the Star Rating for an image.
Full Screen Button
Displays the image in the full screen mode. Click the
image or press any key on the keyboard to restore the
normal display mode.

• If a RAW image is displayed, the [Display Original Image] button displays
beneath it. Clicking this button displays the converted image in the Viewer
Window.
• If you are using Windows XP and display a movie file, the
(Capture Still
Frame) button will display beside the Star Ratings. Clicking this button
extracts still images from movies.

29
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Properties Window
The Properties Window displays when you select an image in the Browser Area and click the
Properties button. The Properties Window does not display in the Preview Mode.
Shows or hides
categories.

Plays a sound memo attached
to an image.

Star Rating
Sets the rating for an
image.

Protect
Prevents an image from being
overwritten or deleted.
Comment
You can type a comment here.
Keywords
Sets the keywords used in
searches.

Shooting Information
Displays detailed
information, such as the
shutter speed and
exposure compensation
setting. The camera model
will determine what
information is displayed.

Image Selector Buttons
Switches between images.

Windows

Brightness Histogram
A graph of the highlights and
shadows distribution in an
image.
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ZoomBrowser EX Features
This section briefly introduces the Task Area functions.
To confirm whether your camera supports these functions, please refer to
Information about Your Camera (p. 85).

Acquire & Camera Settings
Connect to Camera

Clicking this connects to your camera and
opens the Camera Control Window, which lets
you perform the following operations.

•Acquire Images

Downloads images from the camera/memory card (p. 16, 19).
Additionally, you can download sound files recorded with the Sound Recorder function on
the camera.

•Print Images

Selects and prints the images in a camera. You can print numerous ways, using DPOF
settings, the Index Print option, One Photo per Page Print option, or by selecting images
before printing.

•Set to Camera

•Remote Shooting

Allows you to operate the camera shutter from the computer (p. 35).

Connect to EOS Camera

This can only be used with EOS series cameras. For details on this function, see the user guide
for your camera.

Acquire Images from Memory Card

Download images from a memory card (p. 19).
You can also download sound files recorded with the Sound Recorder function, or select
images on the memory card and print them.

View & Classify
View as a Slide Show

Starts a slide show of the images selected in the
Browser Area.

Rename Multiple Files

Changes the file names of the selected images in a single pass.

Classify into Folder

Classifies images and saves them into a specified folder.

Search

Performs image searches using criteria such as the Star Rating, modification date, shooting
date, comments or keywords. Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties Window.

Windows

Sets camera settings, such as the My Camera settings (p. 39). It also uploads images from
the computer to the camera.
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Edit
Edit Image

Allows you to perform image editing, such as
cropping, image correction and red-eye
correction. You can also use it to start other image editing programs.

Stitch Photos

Merges multiple images and creates a single large panoramic image (p. 38).

Edit Movie

Edits movies or still images strung together. You can add text as titles, or background music,
and apply various effects (p. 34).

Process RAW Images

Converts RAW images into standard images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion.

Export
Export Still Images

Allows you to change the image size or type,
and export it as a new image.

Export Movies

Allows you to change the movie size or type, and export it as a new movie.
Extracts still images from movies over a specified interval and saves them as image files
(Windows XP only).

Export Shooting Properties

Allows you to select the necessary data from the shooting information and export it as a text
file.

Export as a Screen Saver

Exports the image as a screen saver file.

Export as a Wallpaper

Exports the image as a wallpaper file.

Backup to CD

Copies images to a CD-R/RW disk for backup.
The Backup to CD function can only be used on computers satisfying the
following requirements.
• Windows XP is preinstalled
• A CD-R/RW drive is included as standard equipment

Windows

Extract frames from a movie
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Print
One Photo per Page Print

Prints one image per page (p. 21).
You can print "photo" prints easily.

Index Print

Lines up small versions of the images in rows and prints.

Print Using Other Software

Select the software to use and then print.

Internet
Email Images

Converts the selected images to the
appropriate size for transmission by e-mail. You
can also use it to automatically start an e-mail program after conversion.
• To return to the previous screen after selecting a task, click [Return to Main
Menu] at the bottom of the task screen.
• Various Help functions are available in ZoomBrowser EX. Click the [Help]
menu, [?] button or [Help] button to display topics about operational
procedures or the functions available.

Windows
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Replaying Movies
1

Double-click an image with a movie icon in ZoomBrowser EX’s Browser Area.
The Viewer Window will open and play the movie.

You can save the displayed
scene as a still image by
clicking here.

You can control the
movie's playback and
sound volume.

QuickTime is required to play and edit movies. To install QuickTime, please follow these
procedures.
1. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
If the installer panel fails to appear automatically, display it using the procedures in the
How to Display the Installer Panel section (p. 12).
2 Click the QuickTime [Install] button.

Follow the onscreen instructions to
proceed with the installation.

Windows

Windows 2000, Windows Me and Windows 98 SE

34
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Editing Movies
You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.
• The QuickTime program is required to replay or edit movies on the Windows
2000, Windows Me or Windows 98 SE platform. Install it during procedures
in the "Replaying Movies" topic in the Windows 2000, Windows Me and
Windows 98 SE section (p. 33).
• Movies are saved as Motion JPEG AVI movies.

1
2
3

Click [Edit] in ZoomBrowser EX’s Main Window, followed by [Edit Movie].
Click [1. Add Images] and select the image (movie or still) you wish to edit.
You can select multiple movies or stills.
Follow the steps at the left of the window to edit the movie and save it.
Follow these steps
to proceed.

Click this button for detailed
operational instructions.

Windows

Instructions

Storyboard Area
Displays thumbnails of the selected
images.
Links images in order from left to right.

Click this button to
play the movie
being edited.

Transition Effects Box
Appears between adjacent images
and displays the symbols of the
transition effects linking images.
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Operating the Shutter Remotely
You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

Preparing for Remote Shooting
1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

• Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.
• Perform the settings described in First Time Camera is Connected to a
Computer (p. 17) the first time you connect the camera to the
computer.
The Camera Control Window will display.

2

5

Click the [Remote shooting] tab.
Click [Starts Remote Shooting].

Select a destination for the captured images and click [OK].

Windows

3
4

Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.
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RemoteCapture Task Window
The RemoteCapture Task window has the following features.
Shows/Hides the
viewfinder or detailed
settings area.

Size and Resolution Selector
Selects the size and resolution at which images are captured.
Rotation Settings
Sets the rotation
parameters for
images after they are
captured.

You can add
comments to images
by placing a check
mark here and
typing text in the
boxes below.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button
Starts or stops the
viewfinder display.
Refresh Button
Resets the exposure,
focus and white
balance.

Set the basic camera settings here.

• The settings available in the RemoteCapture Task window vary between
camera models.
• RemoteCapture Task locks the exposure and focus settings for the subject
matter in the Viewfinder section. If the lighting or distance to the subject
changes, click
to reset these settings.

Windows

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to
display the image
appearing in the
camera’s viewfinder.

Release Button
Releases the
shutter.
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Remote Shooting
Ensure that you turn off your computer’s standby mode before you begin
remote shooting. The device performance cannot be guaranteed if the
computer enters the standby mode.

1
2

Click
and check the subject in the viewfinder.
Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.
If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.
If your camera’s shooting mode is equipped with the Auto Rotate
function and you set it to On, the image will automatically be rotated
and appear in the correct viewing orientation in the RemoteCapture Task
window.

3

Click the [Release] button.

Windows

• You can release the shutter by pressing the camera’s shutter button or
the keyboard’s space key.
• Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.
• You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Merging Panoramic Images - PhotoStitch
You can create a wide panoramic image by merging several images. It is easier to merge
images if they are shot with the camera's Stitch Assist mode because PhotoStitch can
automatically detect the image order and orientation.

Images Shot in Stitch Assist Mode
A sequence of images shot in Stitch Assist mode is saved into a single folder when it is
downloaded from the camera. In addition, the symbol below displays by the image in the
Browser Area.
Symbol displayed by images shot in Stitch
Assist mode.

Starting PhotoStitch
1 Click [Edit] in the ZoomBrowser EX’s Main Window and click [Stitch Photos].
2 Click [1. Select Images] and select several images in the Browser Area.
3 Click [2. Open PhotoStitch].
Instructions

4

Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Windows

• See the Camera User Guide for information about shooting in Stitch
Assist mode.
• Images shot in Stitch Assist mode with a wide converter, teleconverter
or close-up lens cannot be merged accurately.
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Enjoy Customizing Your Camera with the My
Camera Settings
The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.
To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

Displaying the My Camera Window
1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

The Camera Control Window will display.

2
3

Click the [Set to Camera] tab.
Click [Set My Camera].
The My Camera window will display.

Windows

• Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.
• Perform the settings described in First Time Camera is Connected to a
Computer (p. 17) the first time you connect the camera to the
computer.
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The My Camera Window Features
ZoomBrowser EX already contains several pre-recorded My Camera settings. You can check
these items with the My Camera window.
Tabs
Click here to switch between adjusting the settings individually or in themed sets.

Computer
Displays the list of
settings files saved
onto the computer.

Play Button
Plays the audio from the
settings file in the
camera.
Camera
Displays the settings in
the camera.
Delete Button
Deletes a settings file
from the camera.

Play Button
Plays the audio from
the selected settings
file.

Save to Camera Button
Saves a computer
settings file onto the
camera.
Save to PC Button
Saves a camera settings
file onto the computer.

Depending on the camera, the [Return to
factory default settings] button will display.
Clicking this button will return the My Camera
setting to the factory default setting.

Windows

Delete Button
Deletes a settings file from
the computer.
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Saving the My Camera Settings to the Camera
• My Camera settings can be selected and saved in either of two ways to the
camera: individually or in theme sets.
•The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with "Animal~".
Do not detach the interface cable, turn the camera power off or disconnect
the camera from the computer while the My Camera settings are being saved
to the camera or the settings from the camera are being saved to the
computer.

1
2
3

Select the [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer
1 Select the [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

2
3
4

Select the settings files from the Camera list that you wish to save to the
computer.
Click [Save to PC].
Add a name to the settings file you are saving and click [OK].
This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

Windows

Select the settings file you wish to save to the camera from the My Computer list.
Select the setting from the Camera list that you would like to change and click
[Save to Camera].
This concludes the process of saving the My Camera settings to the camera.
The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.
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Adding New Data to the My Camera Window
Create a new image or sound file and add it to the My Camera window.
• Adding Image and Sound Files After Creating Them

Adding Original Start-up Images and Sounds After Creating Them
You can effortlessly create start-up image and sound files using the My Camera Maker
program (Windows XP or Windows 2000 only).

1
2

Click the [Edit] menu in the ZoomBrowser EX Main Window and select [Manage
My Camera].
The My Camera window will display.
Click the [Set individually] tab in the My Camera window, followed by the [Create
My Camera Data] button.
My Camera Maker will start.

Windows

Add File Button
Adds images and sound files for use
as settings files. Added files display
in the list.
Connect to camera Button
Connects to the camera.

3

Follow the instructions at the top part
of the My Camera Maker window and
create image or sound files.
Instructions
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4
5

Once you have saved the file, click
and close the My Camera Maker window.
You have now succeeded in adding the file as a settings file to the computer.
To connect to the camera, click
[Connect to Camera].
You can add the settings files you just
added to the computer to the camera using
the same procedures as in "Saving the My
Camera Settings to the Camera" (p. 41).

Type

Duration in Seconds
11.025 kHz

8.000 kHz

Start-Up Sound

1.0 sec. or less

1.3 sec. or less

Shutter Sound

0.3 sec. or less

0.4 sec. or less

Operation Sound

0.3 sec. or less

0.4 sec. or less

Self-Timer Sound

2.0 sec. or less

2.0 sec. or less

Windows

• Use settings like those below when creating an image file for the startup image using an image editing program other than My Camera
Maker.
Compression Method
: JPEG (Baseline JPEG)
Data Sampling
: 4:2:0 or 4:2:2
Pixels (w x h)
: 320 x 240 pixels
•Use settings like those below when creating a sound file using a sound
recording program other than My Camera Maker.
Compression Method
: WAV (Monaural)
Quantifying Bits
: 8 bit
Sampling Frequency
: 11.025 kHz or 8.000 kHz
Use the following lengths as guidelines for the length of sound file that
can be saved to the camera.
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Using the Software on the Macintosh
Platform – Preparations
This chapter explains the basic procedures for installing the software. Read this material before
you connect the camera to the computer for the first time.

Installing the Software
Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare
• Your camera and computer
• Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

Installation Procedures
1 Close any programs that are running.
2 Place the Canon Digital Camera Solution Disk in the
3

computer’s CD-ROM drive.

Double-click the [Canon Digital Camera Installer] icon
in the CD-ROM window.

4

Click the Digital Camera Software
[Install] button.

Macintosh

Installer Panel
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Select [Easy Installation] and click
[Next].
Select [Custom Installation] to select
programs individually for installation.

6

7

8

9

Click [Agree] if you agree to all of the
terms of the software license
agreement.

Review the installation settings and
click [Next].
Follow the onscreen instructions to
proceed.

When the installation is over, click [OK].

Click [Exit] in the installer panel and
remove the disk from the CD-ROM drive.
This concludes the software installation.

Macintosh

See Uninstalling the Software (p. 72) to delete the software installed
with these procedures.
Continue by downloading images to the computer (p. 46).
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Using the Software on the Macintosh
Platform – The Basics
This chapter explains the procedures for using ImageBrowser to download the camera's images
to the computer and print them.
Read this chapter after completing the preparations in the Using the Software on the
Macintosh Platform – Preparations section.

Downloading Images to the Computer
Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 48).
You may not be able to download images when the camera is connected to a
computer if there are a large number of images (approximately 1000) on the
memory card. Use a memory card reader to download in that case.

Camera to Computer Connection
1

Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.
Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See the
Camera User Guide.

Macintosh

The Camera Control Window will appear.
If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of
the desktop). To set whether this window automatically opens when you connect the
camera to the computer, remove the check mark from the [Start when a camera is
connected] in the [File] menu in the Camera Control window.
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Download images.
Download the images using the camera or
the computer. By default, the downloaded
images are saved into the [Pictures] folder.

Camera Control Window
You can adjust the settings, such as the type
of image downloaded and the destination
folder, by clicking [Preferences].

Using the Camera to Download Images (Direct Transfer Function)
• If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the
(Print/Share) button will light if your camera is equipped with one.
• See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.
Set the Direct Transfer settings on the
camera and press the
(Print/Share)
button or the [SET] button.

Using the Computer to Download Images
Click [Starts to download images].

Macintosh
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• By default, all the images that have yet to be downloaded will download.
• To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.
• Click [Lets you select and download images] to show the camera images
in a list, check the images before downloading and download only
selected images.
The downloaded images are saved into folders according to the shooting date.
At the same time, they will also appear grouped by date in the [Last Acquired
Images] at the top of the Explorer Panel.

[Last Acquired Images]
Clicking the shooting date
displays the images last
downloaded.
Explorer Panel

Destination for the
downloaded images
The downloaded symbol
displays on downloaded
folders.

Thumbnail
According to the default settings, the thumbnails
(tiny versions) of the downloaded images display in
the Browser Window when the downloading is
complete.

Continue by printing out an image (p. 50).

Memory Card Reader Connection
1

The Camera Control Window will appear.
If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of
the desktop). To set whether this window automatically opens when you connect the
camera to the computer, remove the check mark from the [Start when a camera is
connected] in the [File] menu in the Camera Control window.

Macintosh

Insert the memory card into the reader.
Use a separately sold card adapter if required.
See the manual for the memory card reader for details on how to connect and use the
reader.
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Click [Starts to download images].

You can set the type of image to download
and the destination folder by clicking
[Preferences].

• By the default settings, all images are downloaded to the [Pictures]
folder.
• To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the type of image for downloading.
•Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.
• See Memory Card Folder Structure (p. 75) for information about
memory card folder structures and file names.
The downloaded images are saved into folders according to the shooting date.
At the same time, they will also appear grouped by date in the [Last Acquired Images] at
the top of the Explorer Panel.
Continue by printing out an image (p. 50).

Macintosh
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Printing Images
There are three ways in which images may be printed: One Photo per page Print, Index Print
and Layout Print. This section explains the One Photo per page Print method.
Movies cannot be printed, but you can print stills after they have been
extracted from movies and saved to files.

One Photo per page Print
This option prints one image per page in a standard "photo" format. If you select multiple
images, it will print them on the corresponding number of pages.

1

Select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple
images, hold down the [shift] or [ ] (command) key while clicking on images.

A blue frame
displays around
selected images.

2

Click [Print] and select [One Photo per
page Print].

Macintosh
Selecting [Index Print] allows you to print the thumbnails and shooting
information in a chart.
Selecting [Layout Print] allows you to layout and print multiple images on
a single sheet of paper.
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3

Set the categories as you feel necessary.

Selects a printer.
Selects options such as the paper size
and orientation when you click
[Page Setup].
Configures the auto trimming
function.
Place a check mark here to print the
shooting dates/times with the
images.
Sets the number of copies printed.
Click this button to switch between
images if you selected multiple
images.

4

Click [Print].
The Print window will now open.

5

After setting the number of copies, and other settings, click [Print].

6

After the printing finishes, click

to close the window.

This chapter explained the ImageBrowser basics.
Once you have mastered them, try the advanced techniques.
Using the Software on the Macintosh Platform – Advanced Techniques (p. 52).

Using Cameras That Support My Category

Macintosh

When using cameras that support My Category, in addition to classifying by Shooting Date,
My Category also displays at the top of the folder area where the [Last Acquired Images]
message displays after the last image is downloaded.
Also, in addition to the Star Rating it is possible to sort by Category using the [Filter Tool]
function.
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Using the Software on the Macintosh
Platform – Advanced Techniques
This chapter explains various ImageBrowser features.
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the
Using the Software on the Macintosh Platform – The Basics chapter.
To confirm whether your camera supports these functions, please refer to
Information about Your Camera (p. 85).

The ImageBrowser Windows
This section describes the principal ImageBrowser windows: the Browser Window, Viewer
Window and File Information Window.

Browser Window
This window is for displaying and organizing images downloaded to the computer.
Browser Area (p. 53)

Display Mode (p. 54)

Macintosh

Explorer Panel (p. 53)

Display Control Panel (p. 55)

Control Panel (p. 55)
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Explorer Panel
• Use this area to select folders. The images in the selected folder display in the Browser Area.
• If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder

• If [Favorite Folders] is displayed: click [Add] and select a folder.
• If [All Folders] is displayed: select a folder and click [Add to Favorites].
• Downloaded images also appear in the [Last Acquired Images] area at the top of the Explorer
Panel. You can check them in groups sorted by shooting date.

Browser Area
• The images in the folder selected in the Explorer Panel will display here.
The display style will vary according to your Display Mode selection.

Methods for Selecting Images in the Browser Area

• Selecting a single image: click on an image.
• Selecting multiple images: click on the first image and then hold the [shift] or [ ]
(command) key down while clicking on additional images.
• Selecting consecutive images: click on the first image and then hold the [shift] and
[option] keys down while clicking on the last image.
• The following types of icon will display around images according to their attributes.
Images shot with the camera's Stitch Assist mode
RAW images
Movies
Images with sound memo attachments
Protected images
Images shot with the camera's AEB function
Images or movies rotated in display only

Macintosh
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Display Mode
• Selects the display style for the Browser Area.

Preview

This mode displays the image at a larger size as
well as the image information.

List

Displays the images in the folder selected in the
Explorer Panel section in rows and columns.

TimeTunnel

Displays images in chronological order in a
simulated time tunnel. You can move along a
timeline from the past to the present using the
slider that appears at the window's right.

Macintosh
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Display Control Panel
• This panel adjusts the display settings for the Browser Area.
Display Size
Changes the size of the thumbnail in
the Browser Area.

Filter Tool
Use the Star Rating option in the Show menu
to limit the scope of images displayed.

Selection Menu
Click this to select/deselect all
images in the Browser Area.

Hide Buttons
Left:
Hides the Explorer Panel.
Middle: Hides the control panel.
Right: Hides the image
information in the Preview
display mode.

Control Panel
• The control panel contains buttons for executing various functions.

The functions displayed here are explained in the Control Panel Features section (p. 58).

Macintosh
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Viewer Window
Double-click an image in the Browser Area to display it in the Viewer Window.

Zoom
Changes the
image zoom
setting.

Image Selector Button
Switches between
images.
Save Button
Saves the edited image.
Edit Menu
You can edit, performing such things as
cropping, adjusting colors and brightness,
eliminating red eyes and inserting texts.
You can also use it to start up other
programs for editing.
Number of Displays Menu
Displays multiple images at
once. This is handy for
comparing images.

Star Ratings
Menu
Sets the Star
Rating for an
image.
Show Information Menu
Displays the AF frame
(focal point frame) and
the shooting information.
Print Button
Prints the displayed image.
Full Screen Button
Displays the image in the full screen
mode. (You can also double-click an
image to display it in full screen mode).
Click the image or press any key on the
keyboard to restore the normal display
mode.
Synchronize Button
Synchronizes the display
settings when multiple
images are displayed.

Macintosh

• If a RAW image is displayed, the [Show Original Image] button displays
beneath it. Clicking this button displays the converted image in the Viewer
Window.
• If a movie file is displayed, the [Save as Still Image] button will display
beside the Star Ratings.
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File Information Window
The File Information Window displays when you select an image in the Browser Area, click the
[File] menu and select [Get Info]. The File Information Window does not display in the Preview
display mode.
Star Rating
Sets the rating for an image.
Shows or hides
categories.
Comment
You can type a comment
here.
Plays a sound
memo attached
to an image.

Keyword
Sets the keywords used in
searches.
Brightness Histogram
A graph of the highlights
and shadows distribution
in an image.

Lock
Prevents an image
from being
overwritten or
deleted.

Image Selector Buttons
Switches between images.

File Name
You can change
file names.

Shooting Information
Displays detailed information, such
as the shutter speed and exposure
compensation setting. The camera
model will determine what
information is displayed.

Macintosh
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ImageBrowser Features
This section provides a brief introduction to ImageBrowser features.
To confirm whether your camera supports these functions, please refer to
Information about Your Camera (p. 85).

Control Panel Features

Canon Camera
Opens the Camera Control Window, which lets you perform the following operations.

Acquire Images

Downloads images from the camera/memory card (p. 46, 48).
Additionally, you can download sound files recorded with the Sound Recorder function on
the camera.

Print

Selects and prints the images in a camera or memory card. You can print numerous ways:
print all images, print a contact sheet (index) of all images, print using DPOF settings, or by
selecting images before printing.

Set to Camera

Sets camera settings, such as the My Camera settings (p. 67). It also uploads images from the
computer to the camera.

Remote Shooting

Allows you to operate the camera shutter from the computer (p. 63).

View Image
Displays the selected image or movie in the Viewer Window.

SlideShow
Internet

Create Images for Email

Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.

Macintosh

Starts a slide show of the selected images. Click the [View] menu and select [Slide Show
Options] to set the slide show settings.
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Print
One Photo per page Print

Prints one image per page (p. 50).
You can print "photo" prints easily.

Index Print

Lines up small versions of the images in rows and prints.

Layout Print

Allows you to freely arrange multiple images on a single page and print. You can also insert
captions and titles.

Send to Trash
Sends the selected images or folders to the Trash.

Functions Selected from Menus
Search Images: [File] menu, [Search]
Searches for images based on such criteria as Star Ratings, dates, keywords or captions.

Export Images: [File] menu, [Export Images]
•Edit and Save: allows you to change the file type or size and export the file.
•Export Shooting Properties: allows you to export the shooting properties as a text file.
•Export as a Screensaver: Exports the image as a screen saver file.
•Export an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]
•Sort Images: sorts images according to criteria such as the shooting date or Star Rating and
saves them into a specified folder.
•Rename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [RAW image processing]
Converts RAW images. You can adjust the image brightness, contrast and color balance
among other attributes during conversion.

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 66).

Edits movies or still images strung together. You can add titles or background music and
apply various effects (p. 62).

Extracting Stills from Movies: [Edit] menu, [Extract frames from a movie]
Extracts still images from movies over a specified interval and saves them as image files.

Macintosh

Edit Movies: [Edit] menu, [Movie Edit]
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Display Settings: [View] menu, [View Settings]
Hides or shows image information beneath the thumbnail, such as the file name or the
shooting date and time.

Sort Images: [View] menu, [Sort]
Arranges image order in the Browser Area according to criteria such as the filename, file
modification date, file size or shooting date.

Macintosh
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Replaying Movies
1

Double-click an image with a movie icon in ImageBrowser’s Browser Area.
The movie will appear in the Viewer
Window.
Movie icon

2

Click the

button.

You can control the
movie's playback and
sound volume.

You can save the displayed scene
as a still image by clicking here.

Macintosh
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Editing Movies
You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

1
2
3

Select the image(s) to edit in ImageBrowser’s Browser Area (movies or stills).
You can select multiple movies or stills.
Click the [Edit] menu and select [Movie Edit].
Follow the steps displayed in the middle of the window to edit the movie and save
it.
Follow these steps
to proceed.

Instructions

Click this button
for detailed
operational
instructions.

Click this button
to play the movie
being edited.

Storyboard Area
Displays thumbnails of the
selected images.
Links images in order from
left to right.

Transition Effect Box
Appears between adjacent
images and displays the
symbols of the transition
effects linking images.

Macintosh

Using the Software on the Macintosh Platform – Advanced Techniques

63

Operating the Shutter Remotely
You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

Preparing for Remote Shooting
1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

• Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.
• If the Camera Control Window does not automatically appear, click the
[CameraWindow] icon in the Dock (the bar at the bottom of the
desktop).
The Camera Control Window will display.

2

Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.
Click the [Remote shooting] tab.

4

Click [Starts Remote Shooting].

5

Select a destination for the captured images and click [Choose].

Macintosh
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RemoteCapture Task Window
The RemoteCapture Task window has the following features.

Shows/Hides the
viewfinder or
detailed settings
area.

You can add
comments to images
by placing a check
mark here and
typing text in the
boxes below.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to
display the image
appearing in the
camera’s viewfinder.

Size and Resolution Selector
Selects the size and resolution at which
images are captured.
Rotation Settings
Sets the rotation
parameters for
images after they are
captured.
Release Button
Releases the
shutter.
Slide this to zoom
the camera in or out.
Start/Stop Viewfinder
Button
Starts or stops the
viewfinder display.
Refresh Button
Resets the exposure,
focus and white
balance.

Set the camera shooting settings here.

Macintosh

• The settings available in the RemoteCapture Task window vary between
camera models.
• RemoteCapture Task locks the exposure and focus settings for the subject
matter in the Viewfinder section. If the lighting or distance to the subject
changes, click
to reset these settings.
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Remote Shooting
Ensure that you turn off your computer’s sleep mode before you begin remote
shooting. The device performance cannot be guaranteed if the computer
enters the sleep mode.

1
2

Click
and check the subject in the viewfinder.
Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.
If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.
If your camera’s shooting mode is equipped with the Auto Rotate
function and you set it to On, the image will automatically be rotated
and appear in the correct viewing orientation in the RemoteCapture Task
window.

3

Click the [Release] button.
• You can also release the shutter by pressing the camera’s shutter button
or the keyboard’s space key.
• Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.
• You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.

Macintosh
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Merging Panoramic Images - PhotoStitch
You can create a wide panoramic image by merging several images. It is easier to merge
images if they are shot with the camera's Stitch Assist mode because PhotoStitch can
automatically detect the image order and orientation.

Images Shot in Stitch Assist Mode
A sequence of images shot in Stitch Assist mode is saved into a single folder when it is
downloaded from the camera. In addition, the symbol below displays by the image in the
Browser Area.
Symbol displayed by images shot in Stitch Assist
mode.

• See the Camera User Guide for information about shooting in
Stitch Assist mode.
• Images shot in Stitch Assist mode with a wide converter,
teleconverter or close-up lens cannot be merged accurately.

Starting PhotoStitch
1
2

Select a series of images in the ImageBrowser’s Browser Area.
Click the [Edit] menu and select
[PhotoStitch].
Instructions

Merge the images following the
instructions in the guidance panel at the top of the PhotoStitch window.

Macintosh
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Enjoy Customizing Your Camera with the My
Camera Settings
The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.
To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

Displaying the My Camera Window
1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

• Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See the
Camera User Guide.
• If the Camera Control Window does not automatically appear, click the
[CameraWindow] icon in the Dock (the bar at the bottom of the
desktop).
The Camera Control Window will display.

2

Click the [Set to Camera] tab.

Macintosh
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Click [Set My Camera].
The My Camera window will display.
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The My Camera Window
ImageBrowser already contains several pre-recorded My Camera settings items. You can check
these items with the My Camera window.
Type
Select the settings type.

Save to Camera
Save to Computer

Computer
Displays the list
of settings files
saved onto the
computer.

Play Button
Plays the audio from
the settings file in the
camera.
Camera
Displays the settings
in the camera.
Delete Button
Deletes a settings
file from the
camera.

Play Button
Plays the audio from the
selected settings file.

Send to Trash Button
Deletes a settings file
from the computer.

Save to Camera Button
Click here to save the
settings onto the
camera.

Depending on the camera, the [Return
to factory default settings] button will
display. Clicking this button will return
the My Camera setting to the factory
default setting.

Macintosh
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Saving the My Camera Settings to the Camera
• My Camera settings can be selected and saved in either of two ways to the
camera: individually or in theme sets.
•The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with “Animal~”.
Do not detach the interface cable, turn the camera power off or disconnect
the camera from the computer while the My Camera settings are being saved
to the camera or the settings from the camera are being saved to the
computer.

1
2
3

4

Select the type of setting in the Type list box that you wish to save to the camera.
Select the setting from the Computer list that you would like to add.
Select the setting in the Camera list that you would like to change and click the
button.
The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.
Click the [Save to Camera] button.
This concludes the process of saving the My Camera settings to the camera.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer
1 Select the type of setting you wish to save to the computer from the Type list box.
2 Select the setting in the Camera list that you wish to save to the computer.
3 Click the button.
4 Input a file name to the selected setting and click the [OK] button.
Macintosh

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.
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Adding New Data to the My Camera Window
Create a new image or sound file and add it to the My Camera window.
• Adding Image and Sound Files After Creating Them

Create an Original Start-up Image File and then Add It
Start by using an image editing program to create the image file that will become the start-up
image and save it to the computer.

1

Click the [File] menu in the ImageBrowser Main Window and select [Canon
Camera] and [My camera].
The My Camera window will display.

2

Select the [Start-up Image] in Type.

3

Click [Add].

Add Button
Adds images and
sound files for use as
settings files. Added
files display in the list.

Connect to Camera Button
Connects to the camera.

4
5

Select the file you created and click [Open].
This concludes the process for adding new data.
To connect to the camera, click [Connect to Camera].
You can add the settings files you just added to the computer to the camera using the
same procedures as in "Saving the My Camera Settings to the Camera" (p. 69).

Macintosh
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Add an Original Sound File
Change the file to a WAV sound file after you have copied the sound file to the computer.
Then proceed with the steps as described in Create an Original Start-up Image File and then
Add It.
• Use settings like those below when creating an image file for the startup image with an image editing program.
Compression Method
: JPEG (Baseline JPEG)
Data Sampling
: 4:2:0 or 4:2:2
Pixels (w x h)
: 320 x 240 pixels
• Use settings like those below when creating a sound file with a sound
recording program.
Compression Method
: WAV (Monaural)
Quantifying Bits
: 8 bit
Sampling Frequency
: 11.025 kHz or 8.000 kHz
Use the following lengths as guidelines for the length of sound file that
can be saved to the camera.
Type

Duration in Seconds
11.025 kHz

8.000 kHz

Start-Up Sound

1.0 sec. or less

1.3 sec. or less

Shutter Sound

0.3 sec. or less

0.4 sec. or less

Operation Sound

0.3 sec. or less

0.4 sec. or less

Self-Timer Sound

2.0 sec. or less

2.0 sec. or less

Macintosh
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Uninstalling the Software
The procedures for uninstalling the software are only required when you wish to delete the
programs from your computer or when reinstallation is required to fix corrupted files.

Uninstalling the Software (Windows)
This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program. You can
remove other programs with the same procedures.

1

Click the Windows [Start] menu and
select [All Programs] or [Programs],
followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].
The uninstall utility will start and remove
ZoomBrowser EX.

Windows/Macintosh

This chapter explains how to uninstall the programs.
Read the Troubleshooting section in this chapter if you experience a problem using the
programs.
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Uninstalling the USB Driver (Windows)
Uninstall the USB Driver using the following procedures if you are using Windows 2000,
Windows Me or Windows 98 SE.
It is essential to note that you will not be able to download images if you
uninstall the USB driver.

1
2
3

4

Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.
For interface cable connection instructions, see the Camera User Guide.
Click the [Finish] button if the Camera Control Window displays.
Click the [Start] menu and select
[Settings], followed by [Control Panel].

Double-click the [Scanners and
Cameras] icon or folder.

Windows/Macintosh

You do not need to uninstall the USB driver with Windows XP.
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5

Delete your camera model name or
[Canon Camera] in the [Scanners and
Cameras Properties] dialog.
Windows Me users should delete their
camera model or [Canon Camera] in the
[Scanners and Cameras] folder.

Windows Me
Select your camera model name or [Canon Camera], right-click the mouse and select
[Delete].
Windows 98 SE
Select your camera model name or [Canon Camera] and click [Remove]. Then turn off the
camera and remove the interface cable from the computer's USB port.
If your camera model name does not appear here, see the Camera not
detected, Events dialog won’t display or images will not download to the
computer (p. 77) of the Troubleshooting section.

6

Click the Windows [Start] menu and select [Programs], followed by [Canon
Utilities], [Camera TWAIN Driver x.x] and [Uninstall TWAIN Driver]. A version
number appears in place of the “x.x”.

• Windows 2000, Windows 98 SE: Perform Step 6 with no substitutions.
• Windows Me: Substitute the following for the underlined portions of Step 6.
[Camera WIA Driver x.x], [Uninstall WIA Driver]

The uninstall process will start.
To connect the camera to the computer and download after this point, use the following
procedures.
1. Reinstall the driver.
2. Connect the camera to the computer with the interface cable.

Uninstalling the Software (Macintosh)
Uninstall the programs by dragging the application’s folder (the folder in which it was installed)
into the Trash, and then empty the Trash.
Please be careful not to accidentally delete any folders with downloaded
images that may be contained within the application folder.

Windows/Macintosh

Windows 2000
Select your camera model name or [Canon Camera] and click [Remove].
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Memory Card Folder Structure
The images on a memory card are placed in the [DCIM] folder in subfolders labeled
[xxxCANON], where the “xxx” represents a number in the range 100 - 999.

xxxCANON

The folder that holds the settings files for
images in the DCIM folder.
CANONMSC
The folder created when DPOF settings are set.
It holds the DPOF settings files.
MISC
SDR_xxxx.WAV (Files recorded with Sound Recorder)
SNDR

xxxCANON

• *Files with the THM extension are the thumbnail image files for the camera’s index replay
mode.
• The “xxxx” in file names represent four-digit numbers.
• **Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which
is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...
• All folders except the “xxxCANON” folders contain image settings files. Do not open or delete
them.

Windows/Macintosh

DCIM

IMG_xxxx.JPG (JPEG images)
_MG_xxxx.JPG (JPEG images recorded in the
Adobe RGB color space)
CRW_xxxx.CRW (RAW images)
_RW_xxxx.CRW (RAW images recorded in the
Adobe RGB color space)
CRW_xxxx.THM*
STx_xxxx.JPG** (Stitch Assist mode images)
MVI_xxxx.AVI (Movies)
MVI_xxxx.THM*
SND_xxxx.WAV (Sound annotation)
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Troubleshooting
Please read this section if you encounter a problem using the software.

Start by Checking This
Does your computer satisfy the requirements listed in the System
Requirements section (p. 8)?
Is the camera correctly connected to the computer?
See the Camera User Guide for the correct connection procedures. Also
check to ensure that you are using the correct cable and that it is securely
attached at both ends.
Is the camera set to the playback mode? (some models only)
Some models require the camera to be set to the playback mode to
transfer data. See the Camera User Guide for details.
Is the battery sufficiently charged?
Check the battery charge if you are powering the camera with a battery.
You are recommended to use a household power source (AC adapter) to
power the camera when it is connected to a computer (if available for
your camera model).

Problems
Try the suggested solutions to the common problems listed below.

USB driver installation not proceeding well (Windows)
Uninstall the driver (p. 73) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 11).

Windows/Macintosh

Investigate the following points first if you encounter a problem.
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Add New Hardware Wizard or New Hardware Found (Windows 2000)
Wizard displays when the camera is connected to the computer with an
interface cable.
Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve
the problem.

Click the [Finish] button in the Camera Control Window to close it.
Cannot download images or shoot remotely. (For cameras connected to
the computer via an interface cable: only cameras supporting Hi-Speed
USB 2.0).
The problem may be resolved by lowering the transmission speed for data by
following the procedures below.
Solution:
Hold the MENU button on the camera down and press the
(Print/Share)
button and FUNC./SET button simultaneously. In the displayed screen, select [B]
and press the FUNC./SET button.
Camera not detected, Events dialog won’t display or images will not
download to the computer (when camera is connected to the computer
via an interface cable).
Cause 1:
There is a problem with one of the items in the Start by Checking This
section (p. 76).
Solution:
Resolve the problem.
Cause 2:
The USB driver is not installed (Windows only).
Solution:
Install it with the procedures in Installing the Software and USB Driver (p. 11).
Cause 3:
The USB driver is not correctly installed (Windows only).
Solution:
Uninstall the driver (p. 73) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 11).

Windows/Macintosh

Images won’t download into a TWAIN-compliant program (Camera and
computer connected via interface cable (Windows 2000, Windows 98 SE)).
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This section explains the specific steps for each operating system.

Windows XP and Windows 2000
Users of Windows XP and Windows 2000 must first log in as an
Administrator (computer system administrator) to delete a driver.

Check to see if the camera is being recognized as an “other” device and
delete the driver if it is.
1. Windows XP: Click the [Start] menu, followed by [Control Panel],
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and [Control
Panel]. Double-click the [System] icon.
2. Click the [Hardware] tab, followed by [Device Manager].

Windows/Macintosh

Cause 4:
The camera may have been recognized as another device under the
following circumstances (Windows only).
• The camera was connected to the computer before the USB driver was
installed.
• The [Scanners and Cameras] icon or the [Scanners and Cameras] folder cannot
be found in the [Control Panel] or the [Printers and Other Hardware] window.
• Your camera model name, [Canon Camera] or a camera icon does not display
in the [Scanners and Cameras Properties] dialog or the [Scanners and
Cameras] folder.
Solution 1:
Start with the following procedures.
Install the USB driver with the procedures in Installing the Software and USB
Driver (p. 11). Then connect the camera to the computer with the interface
cable and prepare it to transfer data. If the USB driver is already installed,
uninstall (p. 74) it first and then reinstall it.
Solution 2:
If the problem is not resolved with the procedures in Solution 1, continue by
implementing the following procedures. The specific steps are explained below.
1. Check to see if the camera is being recognized as an “other” device.
2. Delete the driver and the setup information files if it is being recognized as an
“other” device.
3. Reinstall the driver.
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3. Click the
symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in these
categories if it is being recognized as an “other” device.

4. Select your camera model name or [Canon Camera], right-click and select
[Delete].
5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.
6. Close the System Properties window.
Step 7 and above are not required for Windows XP.

Delete the setup information files
7. Double-click the [My Computer] icon on the desktop, followed by the [C:]
drive, [WINNT] folder and [inf] folder.

Windows/Macintosh

There are other potential reasons for the problem if the “Other devices”
or “Imaging devices” categories do not appear or your camera model
name or [Canon Camera] does not appear. Proceed to Step 6,
temporarily quit the procedures and investigate the other potential
causes.
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If the [inf] Folder Is Not Visible in the [WINNT] Folder
Use the following procedures to show all files and folders.

This will make the hidden files and folders visible.

8. Look for files for Canon digital cameras that start with [CAP*].
The “*” represents a number, such as 0 or 1.
[CAP*] files come in pairs of [CAP*.inf] and [CAP*.pnf] files (For example,
[CAP0.inf] and [CAP0.pnf]).
9. Double-click the [CAP*] files to check their contents.
Double-clicking a [CAP*.inf] file will open it in the Windows Notepad
program. Look for [;****Canon Camera Driver Setup File****] in the first
line. Note down the names of these files.
Several sets of [CAP*] files may be present in the [inf] folder. Open up
each file to confirm that it is an [CAP*] file for Canon digital cameras
before you do anything with the file.

10.Delete the [CAP*] file set.
Delete the [CAP*.inf] and [CAP*.pnf] file for Canon digital cameras that you
noted down in Step 9.
The [inf] folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.

Windows/Macintosh

Open the [WINNT] folder.
Click the [Tools] menu and select [Folder Options].
Click the [View] tab.
In the [Files and Folders] category in the Advanced Settings section, set [Hidden files
and folders] to [Show hidden files and folders]. Remove the check marks from [Hide
file extensions for known file types] if it is present.
5. Click [OK] to close the dialog.
1.
2.
3.
4.
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Reinstall the driver.
11.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 11).

Windows Me/Windows 98 SE

1. Click the [Start] menu and select [Settings], followed by [Control Panel].
Double-click the [System] icon.
This will display the System Properties window.
2. Click the [Device Manager] tab.
3. Click the
symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in these
categories if it is being recognized as an “other” device.

There are other potential reasons for the problem if the “Other devices”
or “Imaging devices” categories do not appear or your camera model
name or [Canon Camera] does not appear. Proceed to Step 6,
temporarily quit the procedures and investigate the other potential
causes.

4. Select your camera model name or [Canon Camera] and click [Remove].
5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.
6. Click [OK] to close the System Properties window.
Delete the setup information files.
7. Double-click the [My Computer] icon on the desktop, followed by the [C:]
drive, [WINDOWS] or [Windows] folder and [INF] or [Inf] folder.

Windows/Macintosh

Check to see if the camera is being recognized as an “other” device and
delete the driver if it is.
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If the [INF] Folder Is Not Visible in the [WINDOWS] Folder
Use the following procedures to show all files and folders.

This will make the hidden files and folders visible.

8. Find and delete the [DRVDATA.BIN] (or [Drvdata.bin]) and [DRVIDX.BIN] (or
[Drvidx.bin]) files.
9. In the [INF] or [Inf] folder, double-click the [OTHER] or [Other] folder to open
it.
10. Find and delete the [Canon.IncCAP xxx.Inf] file (The xxx
represents numerals.).

You do not need to delete anything if none of the above files are
contained in the [OTHER] folder.
The [INF] folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.

Windows/Macintosh

1. Windows 98 SE: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. Windows 98 SE: Set the [Hide files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show hidden files and
folders].
4. Click [OK] to close the dialog.
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Reinstall the driver
11.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 11).

Zooming Images in ZoomBrowser EX is Slow or Not Working

1. Click the Windows [Start] menu, followed by [Control Panel] and
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98 SE, click the [Start] menu
and select [Settings], followed by [Control Panel].
2. Click the [Display] icon, followed by the [Settings] tab, [Advanced] button and
[Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings] tab,
[Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98 SE, click the [Display] icon, followed by
the [Settings] tab, [Advanced] button and [Performance] tab.
3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.

An error message "Insufficient free memory" displays when
using PhotoStitch
Please try one of the following methods.
• Close all other applications other than PhotoStitch.
• Reduce the size or number of images to combine.
• In the [Save] tab, select [Adjust image...], then in “Saved Image Size“ reduce the size.

If You Were Using ZoomBrowser EX Version 2 or 3
Take the following steps if you were using ZoomBrowser EX version 2 or 3 with Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 5 the titles and comments you
input in version 2/3.
1. Use Windows Explorer to open the [Program] folder within the folder in
which you installed ZoomBrowser EX 5.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Program)
2. Double-click [dbconverter.exe] found in this folder to start this utility.

Windows/Macintosh

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration
setting to a lower setting.
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3. Select the database file you were using up to this point and click the [Start]
button.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd)
This will display the titles and comments input in the earlier versions in the
comments section of ZoomBrowser EX 5.

The moved folder images can now be selected and displayed with
ZoomBrowser EX 5.

Windows/Macintosh

If You Had Images in a Folder Below the Program Files Folder
Image files in the [Program Files] folder or a subfolder cannot be displayed in
ZoomBrowser EX 5 from that location. To display these files, first perform steps
1-3 above and then carry on with Step 4.
4. Use Windows Explorer to copy the folder and the images it contains from the
[Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser
EX\Library One to another location.)
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Information about Your Camera

Non-Supported Programs and Features
Applicable Camera Models
DIGITAL IXUS 900 Ti
DIGITAL IXUS 850 IS
DIGITAL IXUS i7 zoom
PowerShot A710 IS
PowerShot A630

Non-Supported Functions
• The camera does not record RAW images.
• The camera does not support the Display AF Frame function in the View Window.
• The camera shutter cannot be controlled from a computer.
• The camera does not support the Sound Recorder function.

Applicable Camera Models
PowerShot A640

Non-Supported Functions
• The camera does not record RAW images.
• The camera does not support the Display AF Frame function in the View Window.
• The camera does not support the Sound Recorder function.

Applicable Camera Models
PowerShot G7

Non-Supported Functions
• The camera does not record RAW images.
• The camera does not support the Display AF Frame function in the View Window.

Windows/Macintosh

The software package and the procedures for connecting to a computer and preparing for data
transfers vary between camera models. Certain software functions may also not be supported
by some camera models.
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Canon Customer Support
For Canon Customer Support contacts, please see rear of the European Warranty System
(EWS) Booklet supplied with your camera.
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